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About This Manual
This manual explains the basic procedures for using serial data trigger and decode software options for Teledyne
LeCroy oscilloscopes. There are also sections pertaining to the measure, graph and eye diagram capabilities of
TDME options. It is assumed that you have a basic understanding of the serial data physical layer specifications, and
how to use the oscilloscope on which the option is installed. Only features specific to this product are explained in
this manual.

While some images may not exactly match what is on your oscilloscope display—or may show an example taken
from another standard—be assured that the functionality is identical. Product-specific exceptions will be noted in the
text.

Some capabilities described may only be available with the latest version of our MAUI® software. Updates are
available from the software download page at teledynelecroy.com under Oscilloscope Downloads > Firmware
Upgrades.
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Introducing the USB4 and Thunderbolt Decoder Options

Introducing the USB4 and Thunderbolt Decoder Options
The Teledyne LeCroy USB4 decoder options apply software algorithms to extract link layer information from USB
signals measured on your oscilloscope. When displayed on oscilloscopes or in MAUI® Studio remote oscilloscope
software, the extracted information overlays the actual physical layer waveforms, color-coded to provide fast,
intuitive understanding of the relationship between message frames and other time-synchronous events.

Inputs may be probed differential or single-ended.

USB4 D and DME
USB4 D and USB4 DME decode single-lane USB4 traffic at all USB data rates up to Gen3 20 Gbps. For Gen2 speeds
up to 10 Gbps, it is supported on a variety of mid-range oscilloscopes, as well as high-performance platforms.

With the addition of the DMEMeasure/Graph and Eye Diagram capabilities, you can apply a set of automated serial
data timing measurements to signals. Measurement results can be plotted as Histogram, Trend or Track. Signals
can also be eye diagrammed and tested against custom eye masks.

USB4 D and USB4 DME also include USB 2.0 trigger and decode capabilities on those platforms where it is
supported. Download the USB 2.0 Decoders Instruction Manual from our website for information regarding the USB
2.0 decoder and trigger functionality.

USB4-SB TD and TDMP
USB4-SB TD and USB4-SB TDMP decode USB4 Sideband Use signals (SBU1/SBU2) that operate at 1 Mb/s.

The software also enables you to trigger on sideband signal Link Training (LT), Admin Training (AT) and Retimer (RT)
messages, or the occurrence of a CLSE, CRC, RSP Length or RSP Write error.

The TDMP option provides USB-specific PHY measurements, in addition to the generic serial data Measure/Graph
and Eye Diagram capabilities.

Note: If you have installed any other Measure/Graph and Eye Diagram options, these dialogs will appear
when the USB4 decoder is open, even if you do not have the DME or TDMP option installed. They may or
may not appear "grayed out." Functionality is only guaranteed with the DME or TDMP option.
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Serial Decode
The methods described here at a high level are used by all Teledyne LeCroy serial decoders, differing only slightly for
signals with an embedded clock and separate clock and data signals.

Bit-level Decoding
The first software algorithm examines the embedded clock based on a default or user- specified vertical threshold
level. Once the clock signal is extracted, the algorithm examines the traffic to determine whether a data bit is high or
low. The default High and Low levels are automatically determined from a measurement of the amplitude of the
signals acquired by the oscilloscope. Alternatively, they can be manually set by the user. The algorithm intelligently
applies a hysteresis to the rising and falling edge of the serial data signal to minimize the chance of perturbations or
ringing on the edge affecting the data bit decoding.

Note: Although the decoding algorithm is based on a clock extraction software algorithm using a vertical
level, the results returned are the same as those from a traditional protocol analyzer using sampling point-
based decode.

Logical Decoding
After determining individual data bit values, another algorithm performs a decoding of the serial data message after
separation of the underlying data bits into logical groups specific to the protocol (Header/ID, Address Labels, Data
Length Codes, Data, CRC, Parity Bits, Start Bits, Stop Bits, Delimiters, Idle Segments, etc.).

Message Decoding
Finally, another algorithm applies a color overlay with annotations to the decoded waveform to mark the transitions
in the signal. Decoded message data is displayed in tabular form below the grid. Various compaction schemes are
utilized to show the data for the duration of the acquisition, from as little as one serial data message acquisition to
many thousands. In the case of long acquisitions, only the most important information is highlighted, whereas with
the shortest acquisition, all information is displayed with additional highlighting of the complete message frame.

User Interaction
Your interaction with the software in many ways mirrors the order of the algorithms. You will:

l Assign a protocol/encoding scheme and input sources to one of the four decoder panels using the Serial Data
and Decode Setup dialogs.

l Complete the remaining subdialogs required by the protocol/encoding scheme.

l Work with the decoded waveform, result table, and measurements to analyze the decoding.
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Acquiring USB4 Signals for Decoding
Following are our recommendations for acquiring signals for analysis with USB4 or USB4-SB decoders.

Method of Acquisition
Many of our examples show the use of the TF-USB-C-HS test coupon because it enables you to simultaneously
probe and decode USB4 sideband (SB) and high-speed (HS) signals for the most comprehensive use of the decoder
capabilities. However, this is not an acquisition requirement.

Setup for using TS-USB-C-HS to acquire SB and HS USB4 signals.

Method of Triggering
Because the oscilloscope software does not, as of yet, include a USB4 protocol trigger, the preferred method of
triggering acquisitions largely depends on the oscilloscope model you are using.

If you are using a mid-range 12-bit oscilloscope with multi-Gpts memory, you will be able to make longer acquisitions
and capture entire link training sequences, but you will not have access to the HS data. In this case, it is
recommended to install one of the USB4-SB options along with the USB4 option so that you can use the
oscilloscope to trigger on SB signals. If you trigger on the transmitter equalizer register state, TxFFE, that
immediately precedes the scrambler (e.g., DUT enters Preset 6), you should be able to capture the Link Training
packets (LTP) . You will then be able to run the USB4 decoder on these acquisitions to decode ordered sets and LTP.

However, because it is difficult to trigger on the LTP using an oscilloscope alone, if you wish to trigger on specific
packet data, use a protocol analyzer to send an external trigger to the oscilloscope. This is also the recommended
approach if you are using a higher bandwidth oscilloscope, such as a WaveMaster/SDA 8 Zi-B, and especially
LabMasters..
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Setup for using protocol analyzer with TF-USB-C-HS to trigger the oscilloscope on SB signals.

LabMaster oscilloscopes do not support any software serial triggers, such as the USB4-SB triggers. If you are using
a LabMaster, you will have to use an external trigger from either a protocol analyzer or another oscilloscope that
supports the USB4-SB triggers. When using LabMaster for PHY validation testing, use the Voyager M4x to trigger on
either SB register states or LTP to get a reasonable length of record at full sample rate for looking at the Symbol
Locked Eye Diagram.

To use an external trigger, connect the trigger out pulse to the (acquiring) oscilloscope Ext input, and set an Edge
trigger on the Ext source.

You always have the option to use an Edge trigger on a signal from the device under test.
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Start of Acquisition
The USB4 decoder assumes that some type of precoding has been applied to the signal and deploys its descrambler
algorithms depending on the type and other user-defined settings. It is therefore critical to a correct decoding that
you acquire at least from the START-RS-FEC prior to the first TS1 scrambled bits, so that the decoder knows when
the scramble started.

If there is sufficient memory, it is good practice to acquire from the Sync Lock (symbol locked) ordered sets that
precede TS1 to ensure START-RS-FEC is captured. TS1 is where the HS to PHY link training begins negotiation over
TX1/TX2 and RX1/RX2.

USB4 decoding shows the SLOS preceding the START-RS-FEC and the TS1 ordered set.
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Decoding Workflow
We recommend the following workflow for effective decoding:

1. Set up the decoder using the lowest level decoding mode available, but do not yet enable it.

2. Acquire at least one complete transmission reasonably well centered on screen in both directions, with
generous idle segments on both sides.

Note: See Failure to Decode for more information about the required acquisition settings.

3. Stop acquisition, then enable the decoder. It will operate on the acquisition in buffer.

4. Use the various decoder tools to verify that transitions are being correctly decoded. Tune the decoder
settings as needed to produce a satisfactory decoding.

5. Once you are correctly decoding in one mode, continue making small acquisitions of five to eight
transmissions and run the decoder in higher level modes.

6. Finally, run the decoder on acquisitions of the desired length.

When you are satisfied the decoder is working properly, you can disable/enable the decoder as desired without
having to repeat this tuning process, provided the basic signal characteristics do not change.

Decoder Set Up
Use the Decode Setup dialog and its protocol-related subdialogs to configure decoders. Each decoder can use
different protocols and data sources, or have other variations, giving you maximum flexibility to compare different
signals or view the same signal frommultiple perspectives.

1. Touch the Front Panel Serial Decode button (if available on your oscilloscope), or choose Analysis > Serial
Decode from the oscilloscope menu bar.

2. On the Serial Decode dialog, enable the decoder by checking On next to the decoder number. This may be
done any time, although we recommend having an acquisition in buffer before enabling the decoder.

3. Click the Setup button at the end of the row to open the Decode Setup dialog.

Note: The full configuration can only be made from Decode Setup.

4. Enter the input channels (sources) and select the Protocol to be decoded. This selection will drive the other
fields that appear.

Note: Subdialog selections, such as single-ended or differential probing, may affect the input fields
that appear on the Decode Setup dialog.

5. Define the level of decoding on the subdialogs (see below) to the right of the Decode Setup dialog.
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USB4 Decoder Settings
These subdialogs appear when you select Protocol USB4-Gen2Gen3.

USB4 Gen2-Gen3 Subdialog

Choose the Generation of specification used to calculate the bit rate of the signal:

l Gen2 Legacy and Gen3 Legacy use the original Thunderbolt specifications of 10.325 and 20.625 Gbps
respectively.

l Gen2 Rounded and Gen3 Rounded round down these values to 10 and 20 Gbps respectively.

Make a Probe Selection matching your physical setup, Differential or Single Ended, then enter the input channel for
each probe on the Decode Setup dialog.

The decoder assumes some precoding has been applied to the signal and factors that into the decoding. For the
most part, the default Auto setting will determine how to best handle the precoding removal, based on the type of
scramber in use. However, if you find that Auto is producing decoder errors, it may be best for you to manually set
how the decoder handles the Precoding Removal:

l Remove always removes precoding

l Keep always retains precoding

Levels Subdialog

Enter the High-Low threshold Level as either percent amplitude or absolute voltage. Optionally, you can also set a
Hysteresis to prevent false determinations.
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Options Subdialog

Decoding options can be used to remove certain types of decoding from the waveform annotations and result table,
leaving a simplified set of data on display, which is highly recommended for long acquisitions.

Group by Type stacks contiguous transmissions of the same type, similar to how it is done in a protocol analyzer.
The total number of rows stacked is shown in the table Count column.

Ignore Frames removes frame decoding, leaving only the electrical signal display where they occur. This can not only
make the table shorter, it can make the annotations easier to read.

Ignore Idles removes idle decoding, leaving only the electrical signal display where they occur. This greatly reduces
the length of the result table.

TS ordered set frame with frame decoding.

TS ordered set without frame decoding. The important information is still visible.

With no options selected, this result table is nearly 18,000 rows long, showing nothing but SLOS for over 200 rows.

By selecting all options, the entire result table is only nine rows of critical information.
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USB4-SB Decoder Settings
These subdialogs appear when you select Protocol USB4-SB.

Basic Subdialog

Make a Source selection of SBTX, SBRX or both SBTX and SBRX, then enter the input channel for each signal on the
Decode Setup dialog.

Tip: To simplify the user interface, we recommend inputting Router A SBTX on C1 and Router B SBTX on C2.
Likewise, Router A SBRX on C3 and Router B SBRX on C4 when both SBTX and SBRX are decoded.

Choose to view the decoding in either Hex(adecimal) or Symbolic format.

Check Show Raw Bits to add bit decoding to the annotations.

Levels Subdialog

Enter the High-Low threshold Level as either percent amplitude or absolute voltage. Optionally, you can also set a
Hysteresis to prevent false determinations.
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Setting Level and Hysteresis
The Level setting represents the logical level for bit transition, corresponding to the physical Low and High
distinction. Level is normally set as 50% of waveform amplitude, but can sometimes be set as an absolute voltage
(with reference to the waveform 0 level).

Percent mode is easy to set up because the software immediately determines the optimal threshold, but in some
cases it might be beneficial to switch to Absolute mode when available:

l On poor signals, where Percent mode can fail and lead to bad decodes

l On noisy signals or signals with a varying DC component

l On very long acquisitions, where Percent mode adds computational load

The transition Level appears as a dotted, horizontal line across the oscilloscope grid. If your initial decoding indicates
that there are a number of error frames, make sure that Level is set to a reasonable value.

The optional Hysteresis setting imposes a limit above and below the measurement level that precludes
measurements of noise or other perturbations within this band.

A blue marker around the Level line indicates the area of the hysteresis band. Depending on protocol, the Hysteresis
Type may be percent amplitude, vertical grid divisions or absolute voltage level.

Observe the following when setting Hysteresis:

l Hysteresis must be larger than the maximum noise spike you wish to ignore.

l The largest usable hysteresis value must be less than the distance from the level to the closest extreme value
of the waveform.

Hysteresis set as 40 percent of total waveform amplitude (left) and Hysteresis set as equivalent of 1 grid division
(right) around an absolute -200mV Level setting.

Note: Usually, you can set the Level and Hysteresis in different modes. For a few protocols, there is only one
option for setting Level or Hysteresis.
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Failure to Decode
Several conditions may cause a decoder to fail, in which case a message will appear in the first row of the summary
result table, instead of in the message bar as usual. In these cases, the decoding is turned off to protect you from
incorrect data. Adjust your acquisition settings accordingly, then re-enable the decoder.

All decoders will test for the condition Too small amplitude. If the signal’s amplitude is too small with respect to the
full ADC range, the message “Decrease V/Div” will appear. The required amplitude to allow decoding is usually one
vertical division.

If the decoder incorporates a user-defined bit rate (usually these are protocols that do not utilize a dedicated
clock/strobe line), the following two conditions are also tested:

l Under sampled. If the sampling rate (SR) is insufficient to resolve the signal adequately based on the bit rate
(BR) setup or clock frequency, the message "Under Sampled" will appear. The minimum SR:BR ratio required is
4:1. It is suggested that you use a slightly higher SR:BR ratio if possible, and use significantly higher SR:BR
ratios if you want to also view perturbations or other anomalies on your serial data analog signal.

l Too short acquisition. If the acquisition window is too short to allow any meaningful decoding, the message
“Too Short Acquisition” will appear. The minimum number of bits required varies from one protocol to another,
but is usually between 5 and 50.

l Poor signal quality. Care must be taken when probing high speed serial data signals (typically with a high
bandwidth differential probe). Channel loss, reflections and probe loading can degrade the signal. Its best to
probe at the termination of a high speed serial link to minimize probe loading effects and reflections. If the
signal has significant channel loss, the CTLE/DFE equalizers in the SDAIII software can be used to improve the
quality of the signal being decoded.

Note: It is possible that several conditions are present, but you will only see the first relevant message in the
table. If you continue to experience failures, try adjusting the other settings.

Serial Decode Dialog
After decoders have been configured on the Decode Setup dialog, use the Serial Decode dialog to quickly change the
input channels (sources) or turn the decoder on/off. If you change protocols, the last settings configured for that
protocol will be resumed.

To enable decoders, on the same row as Decode N, check On. If there is a valid acquisition, a result table and
annotated waveform appear.

To turn off decoders, deselect the On boxes individually, or touch Turn All Off.

Tip: If you wish to inspect the decoding, best practice is to make single acquisitions, stop, then enable the
decoder to apply it to the buffered acquisition. If you wish to accumulate or graph serial data
measurements, it may be better to run the decoder on continuous acquisitions.
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Reading Waveform Annotations
When a decoder has operated successfully on a valid acquisition, an annotated waveform appears on the
oscilloscope display, allowing you to quickly see the relationship between the protocol decoding and the physical
layer. A colored overlay marks significant bit-sequences in the source signal: Header/ID, Address, Labels, Data
Length Codes, Data, CRC, Parity Bits, Start Bits, Stop Bits, Delimiters, Idle segments, etc. Annotations are customized
to the protocol or encoding scheme.

The amount of information shown on an annotation is affected by the width of the rectangles in the overlay, which is
determined by the magnification (scale) of the trace and the length of the acquisition. Zooming a portion of the
decoded trace by clicking a line in the table will reveal the detailed annotations.

USB4 Decoder Waveform Annotations
These overlays appear on decoded USB4 waveforms and their zoom traces.

Annotation Overlay Color (1) Text (2)

Protocol Error (result compared to FEC calculated from the
data to determine if an error has occurred)

Red Protocol Error

<Type> Frame

<Type> may be: RS-FEC, 64b/66b, 128b/132b

Navy Blue
(behind other items)

<Type> Frame

Start <Type>

<Type> may be: RS-FEC

Green START <type> Bit Pattern

<Type> Ordered Sets

<Type> may be: SKIP; SLOSN; CL_WAKEN.X
TSNOS; De-Skew; TSN; CLN_REQ; CLN_ACK; CL0s_ACK; CL_
NACK; CL_OFF

Fields: SCR, TSID, PDF

Green or Bright Purple <Type> Ordered Set | OS

Idle Packet

Fields: PDF; Supp; HopID; Length; HEC

Aqua Blue <Field> = <symbol>

64b/66b or 128b/132b Packet Header

Fields: RsvdL; PDF; HopID; Length; HEC

Aqua Blue <Field> = <symbol>

<Type> Packet

<Type> may be any USB4 item (e.g., Transport Layer, Credit
Grant)

Green <Type> Record

Packet Footer

Fields: Control; Data; Redundancy Byte

Green <Field> = <symbol>

1. Combined overlays affect the appearance of colors.
2. Text in brackets < > is variable. The amount of text shown depends on your zoom factors.
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Initial decoding of USB4 waveform. At this resolution, very little information is visible on the overlay.

Zoom of RS-FEC Frame. Much more annotation detail is visible.
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USB4-SB Decoder Waveform Annotations
These overlays appear on decoded USB4 sideband waveforms and their zoom traces.

Annotation Overlay Color (1) Text (2)

Protocol Error (result compared to CRC calculated from
the data to determine if an error has occurred)

Red Protocol Error

<Type> Transaction

<Type> may be: Admin (AT), Retimer (RT), Link (LT)

Navy Blue
(behind packets)

<Type> Transaction

Packet Start/Stop Bits Grey Start | Stop

Data Link Escape symbol, indicating the beginning of a
transaction

<Type> may be DLE, ETX

Cyan Blue <Type>(value)

Link State Event (LSE) symbol, identifying the originator's
state or the adapter state

<Type> may be: Admin (AT), Retimer (RT), Link (LT)

Bright Purple
(behind other fields)

<Type> <STX | SRX> = value

Header Control Fields

<Type> may be : Command, Request, Response,
Recipient, Responder, Addressed, Broadcast

Tan
(inside header packet)

<Type>(value)

Header Data

<Type> may be: Admin (AT), Retimer (RT), Link (LT)

Cyan Blue
(inside header packet)

Start<Type>(value)

Sideband Register Packet

<Type> may be: any USB4 Sideband Register including
Vendor ID, Product ID, Opcode, Metadata, Link
Configuration, TxFFE

Orange Reg:<Type>(value)

Length Packet Lavender Gray Length = value

Read/Write Field Olive Green
(inside length packet)

Read | Write

Payload Data Packet Aqua Blue Data = value

Cyclic Redundancy Check Royal Blue CRC = value

1. Combined overlays affect the appearance of colors.
2. Text in brackets < > is variable. The amount of text shown depends on your zoom factors.

14



Serial Decode

Initial decoding of USB4 sideband waveform. At this resolution, very little information is visible on the overlay.

Zoom of single index. Much more annotation detail is visible.
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Serial Decode Result Table
When you have selected to turn a decoder On or to View Decode, and a valid acquisition has been decoded using
that protocol, a table summarizing the decoder results appears below the grids. This result table provides a view of
data as decoded during the most recent acquisition, even when there are too many bursts for the waveform
annotation to be legible.

Tip: The result table does not have to be visible in order for the decoder to function. Hiding the table can
improve performance when your aim is to use the decode in downstream processes, like measurements.

Table Rows
Each row of the table represents one index of data found within the acquisition. What exactly this represents
depends on the protocol and how you have chosen to "packetize" the data stream when configuring the decoder.

When multiple decoders are run at once, the index rows are interleaved in a summary table, ordered according to
their acquisition time. The Protocol column is colorized to match the input source that resulted in that index.

Note: The interleaved summary table will default to the lowest common decoding (e.g., hexadecimal if both
support that, but only one supports symbolic).

You can change the number of rows displayed on the table at one time. The default is five rows.

Swipe the table up/down or use the scrollbar at the far right to navigate the table. See Using the Result Table for
more information about how to interact with the table rows to view the decoding.

Table Columns
When a single decoder is enabled, the result table shows the protocol-specific details of the decoding. This detailed
result table may be customized to show only selected columns. A summary result table combining results from two
decoders always shows these columns.

Column Extracted or Computed Data

Index Number of the line in the table

Time Time elapsed from start of acquisition to start of message

Protocol Protocol being decoded

Message Message identifier bits

Data Data payload

CRC Cyclic Redundancy Check sequence bits

Status Any decoder messages; content may vary by protocol

Example summary result table, with results from two decoders interleaved on one table.

When you select the Index number from the summary result table, the detailed results for that index drop-in below it.
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Example summary result table showing drop-in detailed result table.

Exporting Result Table Data
You can manually export the detailed result table data to a .CSV file:

1. Press the Front Panel Serial Decode button, or choose Analysis > Serial Decode, then open the Decode Setup
tab.

2. Optionally, touch Browse and enter a new File Name and output folder.

3. Touch the Export Table button.

Export files are by default created in the D:\Applications\<protocol> folder, although you can choose any other folder
on the oscilloscope or any external drive connected to a host USB port. The data will overwrite the last export file
saved, unless you enter a new filename.

Note: Only rows and columns displayed are exported. When a summary table is exported, a combined file is
saved in D:\Applications\Serial Decode. Separate files for each decoder are saved in
D:\Applications\<protocol>.

The Save Table feature will automatically create tabular data files with each acquisition trigger. The file names are
automatically incremented so that data is not lost. Choose File > Save Table from the oscilloscope menu bar and
select Decodex as the source.
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USB4 Result Table
This extracted data appears on the USB4 detailed result table.

Column Extracted or Computed Data

Index
(always shown)

Number of the line in the table

Time Time elapsed from start of acquisition to start of transmission

Duration Time within acquisition represented by transmissions in that row of the table. This may com-
prise a single transmission or a stacked group of transmissions of the same type.

Type Transmission type (e.g., Idle, Electrical Idle, SKIP, Link Command, TP, LFPS, Data Packet
Header, Data Packet Payload)

Type ID Transmission Type ID

Data Hexadecimal decoding of the packet data

PDF Protocol Defined Field identifying the Link Management or Control packet type. Contents
depend on packet type. Tunneled Packets: defined by Protocol Adapter Layer. Link Man-
agement and Control Packets: together with the SuppID and HopID fields, identifies the Link
Management or Control Packet.

Supp Supplemental ID for Link Management packets, used to distinguish certain types of Link Man-
agement Packets that need additional distinction.

HopID HopID, uniquely identifies a Path in the context of a Link .

Length Number of 32-bit chunks in the transmission.

Details Plain text description of the transmission type(s) on that row. When the user has opted to
Ignore Frames or Ignore Idles, the message that "Tabling of Frames|Idles inhibited."

Count Number of transmissions of the same Type that are stacked in this one row of the table

Section of typical USB4 detailed result table.
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USB4-SB Result Table
This extracted data appears on the USB4-SB detailed result table.

Column Extracted or Computed Data

Index
(always shown)

Number of the line in the table

Time Time elapsed from start of acquisition to start of transmission

Type Transaction type—Link (LT), Retimer (RT) or Admin. (AT)

Link/STX Whether transmission is a Command or Response

R/W For Addressed Retimer and Admin transactions, whether transmission is a Read or Write

LEN Transmission length

RT B/A Whether transmission is a Broadcast or Addressed

Register Retimer or Admin register data carried by packet

Data Extracted hexadecimal or symbolic data

CRC Cyclic Redundancy Check bits

Status Indicates errors such as CRC and Partial Packet Errors

Section of typical USB4-SB detailed result table.
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Using the Result Table
Besides displaying the decoded serial data, the result table helps you to inspect the acquisition.

Zoom & Search
Touching any cell of the table opens a zoom centered around the part of the waveform corresponding to the index.
The Zn dialog opens to allow you to rescale the zoom, or to Search the acquisition. This is a quick way to navigate to
events of interest in the acquisition.

Tip: When in a summary table, touch any data cell other than Index and Protocol to zoom.

The table rows corresponding to the zoomed area are highlighted, as is the zoomed area of the source waveform.
The highlight color reflects the zoom that it relates to (Z1 yellow, Z2 pink, etc.). As you adjust the zoom scale, the
highlighted area may expand to several rows of the table, or fade to indicate that only a part of that Index is shown in
the zoom.

When there are multiple decoders running, each can have its own zooms of the decoding open at once. In this case,
multiple rows of the summary table are highlighted to show which indexes are shown in the zooms. These highlights
will be different colors to indicate which rows correspond to each decoder.

Note: The zoom number is no longer tied to the decoder number. The software tries to match the numbers,
but if it cannot it uses the next empty zoom in the sequence.

Example multi-decoder summary table, both indexes highlighted.

Filter Results
Columns of data with a drop-down arrow in the header cell can be filtered:

Touch the header cell to open the Decode Table Filter dialog.

Select a filter Operator and enter a Value that satisfies the filter condition.

Operators Data Types Returns

=, ≠ Numeric or Text Exact matches only
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Operators Data Types Returns

>, ≥, <, ≤ Numeric All data that satisfies the operator

In Range, Out Range Numeric All data within/without range limits

Equals Any (on List),
Does Not Equal Any (on List)

Text All data that is/is not an exact match to any full value on the list. Enter a
comma-delimited list of values, no spaces before or after the comma,
although there may be spaces within the strings.

Contains, Does Not Contain Text All data that contains or does not contain the string

Note: Once the Operator is selected, the dialog shows the Value format that may be entered. Numeric
values must be within .01% tolerance to be considered a match. Text values are case-sensitive, including
spaces within the string.

Select Enable to turn on the column filter; deselect it to turn off the filter. Use the Disable All button to quickly turn off
multiple filters. The filter settings remain in place and can be re-enabled on subsequent decodings.

Those columns of data that have been filtered will have a funnel icon (similar to Excel) in the header cell, and the
index numbers will be colorized.

Example filtered decoder table.

On summary tables, only the Time, Protocol, and Status columns can be filtered.

If you apply filters to a single decoder table, the annotation is applied to only that portion of the waveform
corresponding to the filtered results, so you can quickly see where those results occurred. Annotations are not
affected when a summary table is filtered.

Also, eye diagrams are modified to represent only the filtered results, which can help to identify exactly which indices
of data are the cause of signal integrity problems.

View Details
When viewing a summary table, touch the Index number in the first column to drop-in the detailed decoding of that
record. Touch the Index cell again to hide the details.

If there is more data than can be displayed in a cell, the cell is marked with a white triangle in the lower-right corner.
Touch this to open a pop-up showing the full decoding.

Navigate
In a single decoder table, touch the Index column header (top, left-most cell of the table) to open the Decode Setup
dialog. This is especially helpful for adjusting the decoder during initial tuning.

When in a summary table, the Index column header cell opens the Serial Decode dialog, where you can
enable/disable all the decoders. Touch the Protocol cell to open the Decode Setup dialog for the decoder that
produced that index of data.
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Customizing the Result Table
You may customize the size of the result table by changing the Table # Rows setting on the Decode Setup dialog.
Keep in mind that the deeper the table, the more compressed the waveform display on the grid, especially if there are
also measurements turned on.

Performance may be enhanced if you reduce the number of columns in the result table to only those you need to
see. It is also especially helpful if you plan to export the data.

1. On the Decode Setup tab, touch the Configure Table button.

2. On the View Columns pop-up dialog, mark the columns you want to appear and clear those you wish to
remove. Only those columns selected will appear on the oscilloscope display.

Note: If a column is not relevant to the decoder as configured, it will not appear.

To return to the preset display, touch Default.

3. Touch the Close button when finished.

You may also use the View Columns pop-up to set a Bit Rate Tolerance percentage. When implemented, the
tolerance is used to flag out-of-tolerance messages (messages outside the user-defined bitrate +- tolerance) by
colorizing in red the Bitrate shown in the table.

Exporting Result Table Data
You can manually export the detailed result table data to a .CSV file:

1. Press the Front Panel Serial Decode button, or choose Analysis > Serial Decode, then open the Decode Setup
tab.

2. Optionally, touch Browse and enter a new File Name and output folder.

3. Touch the Export Table button.

Export files are by default created in the D:\Applications\<protocol> folder, although you can choose any other folder
on the oscilloscope or any external drive connected to a host USB port. The data will overwrite the last export file
saved, unless you enter a new filename.

Note: Only rows and columns displayed are exported. When a summary table is exported, a combined file is
saved in D:\Applications\Serial Decode. Separate files for each decoder are saved in
D:\Applications\<protocol>.

The Save Table feature will automatically create tabular data files with each acquisition trigger. The file names are
automatically incremented so that data is not lost. Choose File > Save Table from the oscilloscope menu bar and
select Decodex as the source.
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Searching Decoded Waveforms
Touching the Action toolbar Search button button on the Decode Setup dialog creates a 10:1 zoom of the center of
the decoder source trace and opens the Search subdialog.

Touching the any cell of the result table similarly creates a zoom and opens Search, but of only that part of the
waveform corresponding to the index (plus any padding).

Tip: In summary table mode, touch any cell other than Index and Protocol to create the zoom.

Basic Search
On the Search subdialog, select what type of data element to Search for. These basic criteria vary by protocol, but
generally correspond to the columns of data displayed on the detailed decoder result table.

Optionally:

l Check Use Value and enter the Value to find in that column. If you do not enter a Value, Search goes to the
beginning of the next data element of that type found in the acquisition.

l Enter a Left/Right Pad, the percentage of horizontal division around matching data to display on the zoom.

l Check Show Frame to mark on the overlay the frame in which the event was found.

After entering the Search criteria, use the Prev and Next buttons to navigate to the matching data in the table,
simultaneously shifting the zoom to the portion of the waveform that corresponds to the match.

The touch screen message bar shows details about the table row and column where the matching data was found.

Advanced Search
Advanced Search allows you to create complex criteria by using Boolean AND/OR logic to combine up-to-three
different searches. On the Advanced dialog, choose the Col(umns) to Search 1 - 3 and the Value to find just as you
would a basic search, then choose the Operator(s) that represent the relationship between them.
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Decoding in Sequence Mode
Decoders can be applied to Sequence Mode acquisitions. In this case, the index numbers on the result table are
followed by the segment in which the index was found and the number of the sample within that segment: index
(segment-sample).

Note: For some protocols, the Serial Trigger does not support Sequence Mode acquisitions, although you
could still decode Sequence Mode acquisitions made using a different trigger type.

Example filtered result table for a sequence mode acquisition.

In the example above, each segment was triggered on the occurrence of ID 0x400, which occurred only once per
segment, so there is only one sample per segment. The Time shown for each index in a Sequence acquisition is
absolute time from the first segment trigger to the beginning of the sample segment.

Otherwise, the results are the same as for other types of acquisitions and can be zoomed, filtered, searched, or used
to navigate. When a Sequence Mode table is filtered, the waveform annotation appears on only those segments and
samples corresponding to the filtered results.

Note: Waveform annotations can only be shown when the Sequence Display Mode is Adjacent. Annotations
are not adjusted when a Sequence Mode summary table is filtered, only the result table data.

Multiple decoders can be run on Sequence Mode acquisitions, but in a summary table, each decoder will have a first
segment, second segment, etc., and there may be any number of samples in each. As in any summary table, the
samples will be interleaved and indexed according to their actual acquisition time. So, you may find (3-2) of one
decoder before (1-1) of another. Filter on the Protocol column to see the sequential results for only one decoder.
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Improving Decoder Performance
Digital oscilloscopes repeatedly capture "windows in time". Between captures, the oscilloscope is processing the
previous acquisition.

The following suggestions can improve decoder performance and enable you to better exploit the long memories of
Teledyne LeCroy oscilloscopes.

Where possible, decode Sequence Mode acquisitions. By using Sequence mode, you can take many shorter
acquisitions over a longer period of time, so that memory is targeted on events of interest.

Note: For some protocols, the Serial Trigger does not support Sequence Mode acquisitions, although you
could still decode Sequence Mode acquisitions made using a different trigger type.

Parallel test using multiple oscilloscope channels. Up-to-four decoders can run simultaneously, each using different
data or clock input sources. This approach is statistically interesting because multi-channel acquisitions occur in
parallel. The processing is serialized, but the decoding of each input only requires 20% additional time, which can
lessen overall time for production validation testing, etc.

Avoid oversampling. Too many samples slow the processing chain.

Optimize for analysis, not display. The oscilloscope has a preference setting (Utilities > Preference Setup >
Preferences) to control how CPU time is allocated. If you are primarily concerned with quickly processing data for
export to other systems (such as Automated Test Equipment) rather than viewing it personally, it can help to switch
the Optimize For: setting to Analysis.

Decrease the number of rows and columns in tables. Only the result table rows and columns shown are exported. It
is best to reduce tables to only the essential columns if the data is to be exported, as export time is proportional to
the amount of data exchanged.
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Serial Trigger
"T" options provide advanced serial data triggering in addition to decoding. Serial data triggering is implemented
directly within the hardware of the oscilloscope acquisition system. The serial data trigger scrutinizes the data
stream in real time to recognize "on-the-fly" the user-defined serial data conditions. When the desired pattern is
recognized, the oscilloscope takes a real-time acquisition of all input signals as configured in the instrument's
acquisition settings. This allows decode and analysis of the signal being triggered on, as well as concomitant data
streams and analog signals.

Note: The trigger and decode systems are independent, although they are seamlessly coordinated in the
user interface and the architecture. It is therefore possible to use the serial trigger without decoding the
acquisition, or to decode acquisitions made without using the serial trigger.

Requirements
Serial trigger options require the appropriate hardware (please consult support), an installed option key, and the
latest firmware release.

Restrictions
The serial trigger operates on only one protocol at a time. It is therefore impossible to express a condition such as
"trigger on CAN frames with ID = 0x456 followed by LIN packet with Adress 0xEBC."

USB4-SB Trigger Setup
The Trigger Types available in USB4-SB TD and TDMP are equivalent to those found in the Teledyne LeCroy Voyager
Power Delivery Compliance Tester, which enables debugging of USB compliance failures.

Tip: As an alternative to using the USB4-SB triggers, the Voyager can be used to cross-trigger the
oscilloscope through its 'Trigger Out' capabilities. Connect the trigger out signal to the oscilloscope Ext In,
then configure an Edge trigger using the Ext source, rather than a serial trigger.

To access the serial trigger dialogs:

l Touch the Trigger descriptor box, or choose Trigger > Trigger Setup from the Menu Bar.

l Touch the Serial Type button, and the USB4-SB Standard button.

Then, working from left to right, make the desired selections from the USB4-SB dialog.

Source Setup
For all triggers, enter the trigger Source input channel and the determination Threshold value.

Error Trigger
Choose Trigger Type Errors and select the error types that will fire the trigger. You may choose as many as you wish.
The oscilloscope will trigger on finding the next error of any selected type in the data stream.
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Link Training Packet Trigger
Choose Trigger Type Link LT, then choose which LSE Symbol on which LSE Lane will fire the trigger.

Retimer and Admin Packet Triggers
Choose the Trigger Type of either Retimer RT (shown here) or Admin AT, and whether triggering on the next
Broadcast packet of that type, or an Addressed packet.

If triggering on an Addressed packet, enter the identifying conditions:

l Command, Response or Any type of transmission (CmdNotResp)
l Read, Write or Any type of transmission (WnR)
l Transmission Register

For TxFFE Register triggers, also select the:

l Field within the packet to search and Field Value that fires the trigger
l Packet Lane

Note: Selecting Any will simply fire on the next occurrence of a packet of the triggering type. To make the
trigger most effective, specify as many conditions as you can.
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Linking Trigger and Decoder
A quick way to set up a serial trigger is to link it to a decoder by checking the Link to Trigger ("On") box on the Serial
Decode dialog. Linking trigger and decoder allows you to configure the trigger with the exact same values that are
used for decoding the signal (in particular the bit rate), saving the extra effort needed to re-enter values on the serial
trigger set up dialogs.

While the decoder and the trigger have distinct sets of controls, when the link is active, a change to the bit rate in the
decoder will immediately propagate to the trigger and vice-versa.

Using the Decoder with the Trigger
A key feature of Teledyne LeCroy trigger and decode options is the integration of the decoder functionality with the
trigger. While you may not be interested in the decoded data per se, using the decoded waveform can help with
understanding and tuning the trigger.

Stop and Look
Decoding with repetitive triggers can be very dynamic. Stop the acquisition and use the decoder tools such as
Search, or oscilloscope tools such as TriggerScan, to inspect the waveform for events of interest. Touch and drag
the paused trace to show time pre- or post-trigger.

Optimize the Grid
The initial decoding may be very compressed and impossible to read. Try the following:

l Increase the height of the trace by decreasing the gain setting (V/Div) of the decoder source channel. This
causes the trace to occupy more of the available grid.

l Change your Display settings to turn off unnecessary grids. The Auto Grid feature automatically closes unused
grids. On many oscilloscopes, you can manually move traces to consolidate grids.

l Close setup dialogs.

Use Zoom
The default trigger point is at zero (center), marked by a small triangle of the same color as the input channel at the
bottom of the grid. Zoom small areas around the trigger point. The zoom will automatically expand to fit the width of
the screen on a new grid. This will help you to see that your trigger is occurring on the bits you specified.

If you drag a trace too far left or right of the trigger point, the message decoding may disappear from the grid. You
can prevent "losing" the decode by creating a zoom of whatever portion of the decode interests you. The zoom trace
will not disappear when dragged and will showmuch more detail.
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Saving Trigger Data
The message decoding and the result table are dynamic and will continue to change as long as there are new trigger
events. As there may be many trigger events in long acquisitions or repetitive waveforms, it can be difficult (if not
impossible) to actually read the results on screen unless you stop the acquisition. You can preserve data concurrent
with the trigger by using the AutoSave feature.

l AutoSave Waveform creates a .trc file that copies the waveform at each trigger point. These files can be
recalled to the oscilloscope for later viewing. Choose File > Save Waveform and an Auto Save setting of Wrap
(overwrite when drive full) or Fill (stop when drive full). The files are saved in D:\Waveforms.

l AutoSave Table creates a .csv file of the result table data at each trigger point. Choose File > Save Table and an
Auto Save setting of Wrap or Fill. The files are saved in D:\Tables.

Caution: If you have frequent triggers, it is possible you will eventually run out of hard drive space. Choose
Wrap only if you're not concerned about files persisting on the instrument. If you choose Fill, plan to
periodically delete or move files out of the directory.
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Measure/Graph
The installation of the Measure/Graph package (included with "ME" and "MP" options) adds a set of measurements
and plots designed for serial data analysis to the oscilloscope's standard measurement capabilities. Measurements
can be quickly applied without having to leave the waveform or tabular views of the decoding.

Note: This capability will only function properly if an "ME" or "MP" option for the protocol decoded is
installed, although the dialogs will appear if any Measure/Graph options are installed.

Serial Data Measurements
These measurements designed for debugging serial data streams can be applied to the decoded waveform.
Measurements appear in a tabular readout below the grid (the same as for any other measurements) and are in
addition to the result table that shows the decoded data. You can set up as many measurements as your
oscilloscope has parameter locations.

Note: Measurements appear in the Serial Decode sub-menu of the Measure Setup menu and may have
slightly different names. For example, the CAN sub-menu has measurements for CAN to Value instead of
Message to Value, etc. The measurements are the same.

Measurement Filters Description

View Serial Encoded Data as
Analog Waveform

Simplified set up of a Message to Value parameter and graph. Performs a
Digital-to-Analog Conversion (DAC) of the embedded digital data and dis-
plays it as an analog waveform.

Message to Value ID, Value Extracts a selected portion of the decoded data to a measurement para-
meter location, with optional conversion of value. Data may be selected
by ID and/or data field position.

Message to Analog ID, Data, Analog Computes time from start of first message that meets conditions to
crossing threshold on an analog signal. If the analog condition precedes
the message condition, no measurement is performed.

Message to Message ID, Data Computes time from start of first message that meets conditions to start
of the next message that meets conditions.

Time at Message ID, Data Computes time from trigger to start of each message that meets con-
ditions.

Analog to Message ID, Data, Analog Computes time from crossing threshold on an analog signal to start of
first message that meets conditions. If the message condition precedes
the analog condition, no measurement is performed.

Delta Messages ID, Data Computes time difference between two messages on a single decoded
line.

Bus Load ID, Data Computes the load of selected messages on the bus (as a percent).

Message Bitrate ID, Data Computes the bitrate of selected messages within the decoded stream.

Number of Messages ID, Data Computes the total number of messages in the decoding that meet con-
ditions.
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Graphing Measurements
The Measure/Graph package include simplified methods for plotting measurement values as:

l Histogram - a bar chart of the number of data points that fall into statistically significant intervals or bins. Bar
height relates to the frequency at which data points fall into each interval/bin. Histogram is helpful to
understand the modality of a parameter and to debug excessive variation.

l Trend - a plot of the evolution of a parameter over time. The graph's vertical axis is the value of the parameter;
its horizontal axis is the order in which the values were acquired. Trending data can be accumulated over many
acquisitions. It is analogous to a chart recorder.

l Track - a time-correlated accumulation of values for a single acquisition. Tracks are time synchronous and
clear with each new acquisition. Track can be used to plot data values and compare them to a corresponding
analog signal, or to observe changes in timing. A parameter tracked over a long acquisition could provide
information about the modulation of the parameter.

To graph a measurement, just select the plot type from the Measure/Graph dialog when setting up the
measurement. All plots are Math functions that open along side the deocoding in a separate grid.

Measure/Graph Setup Dialog
Use the Measure/Graph Setup dialog to select the parameter to apply to the decoded waveform while
simultaneously graphing the results.

1. Select the Measurement to apply and the Destination parameter (Pn) to which to assign it.

2. The active decoder is preselected in Source 1, indicating the measurement will be applied to the decoder
results; change it if necessary. If the measurement requires it, also select an appropriate Source 2 (such as an
analog waveform for comparison).

3. Optionally:

l Touch Graph to select a plot type. Also select a Destination function (Fn) for the plot.

l Touch Apply & Configure to set a filter, gate or other qualifiers on the measurement.
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Filtering Measurements
Certain serial decode measurements can be filtered to include only the results from specified IDs or specific data
patterns. As with all measurements, you can set a gate to restrict measurements to a horizontal range of the grid
corresponding to a specific time segment of the acquisition.

After creating a measurement on the Measure/Graph Setup dialog, touch Apply&Configure. The touch screen
display will switch to the standard Measure setup dialogs for the parameter you selected. Set filter conditions on the
right-hand subdialogs that appear next to the Pn dialogs.

ID Filter
This filter restricts the measurement to only frames/packets with a specific ID value. Settings on this dialog may
change depending on the protocol.

1. On the Main subdialog, choose to Filter by ID or ID + Data.

2. On the ID subdialog, choose to enter the ID in Binary or Hex(adecimal) format.

3. If the field appears, select the # Bits used to define the frame ID. (This will change the ID Value field length.)

4. Using the ID Condition and ID Value controls, create a condition statement that describes the IDs you want
included in the measurement. To set a range of values, also enter the ID Value To.

Tip: On the value entry pop-up: use the arrow keys to position the cursor; use Back to clear the
previous character (like Backspace); use Clear to clear all characters.

Data Filter
This restricts measurements to only frames containing extracted data that matches the filter condition. It can be
combined with a Frame ID filter by choosing ID+Data on the Main subdialog.

Use the same procedure as above to create a condition describing the Data Value(s) to include in the measurement.
Use "X" as a wild card ("Don't Care") in any position where the value doesn't matter.

Optionally, enter a Start Position within the data field byte to begin seeking the pattern, and the # Bits in the data
pattern. The remaining data fields positions will autofill with "X".
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Note: For MsgtoMsg measurements, the data condition is entered twice: first for the Start Message and
then for the End Message. The measurement computes the time to find a match to each set of conditions.

Analog Settings
The measurements AnalogToMsg and MsgToAnalog allow you to use crossing level and slope to define the event in
the Analog waveform that is to be used as the reference for the measurement.

As with the decoder, Level may be set as a percentage of amplitude (default), or as an absolute voltage level by
changing Level Is to Absolute. You can also use Find Level to allow the oscilloscope to set the level to the mean Top-
Base amplitude.

A Slope and Hysteresis selection is also offered. The width of the Hysteresis band is specified in milli-divisions. See
Setting Level and Hysteresis for more information on using these controls.
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Eye Diagrams
The "ME" and "MP" options provide easy eye diagram setup and eye mask testing.

Note: This capability will only function properly if an "ME" or "MP" option for the protocol decoded is
installed, although the dialogs will appear if any Measure/Graph options are installed. DMP/TDMP
optionsoften have more eye diagram selections in the PHY tests found on the Analysis menu.

Eye diagrams are a key component of serial data analysis. They are used both quantitatively and qualitatively to
understand the quality of the signal communications path. Signal integrity effects such as intersymbol interference,
loss, crosstalk and EMI can be identified by viewing eye diagrams, such that the eye is typically viewed prior to
performing any further analysis.

The eye diagram shows all values a digital signal takes on during a single bit period. The bit period (also referred to
as unit interval, or UI) is defined by the data clock, whether explicit or extrapolated depending on the protocol. Each
pixel in the eye takes on a color that indicates how frequently a signal has passed through the time and voltage
specified for that pixel.

Note: Serial decode eye diagrams show the decoded signal as it has been configured for the result table.
They are not persistent, as are eye diagrams generated in some other serial data analysis software; the eye
will change from one acquisition to the next and when the result table is filtered.

Our recommended approach for using the eye diagrams is to:

l Make single acquisitions with decoder and eye diagram enabled to test both are working correctly.

l Make a normal acquisition with Mask Testing and Stop On Failure enabled in the Mask Failure Locator, or with
a Pass/Fail test set on one of the eye parameters.

Eye Diagram Setup Dialog

Create Eye Diagram
Open the Eye Diagram Setup dialog and select the Decode for which to create an eye diagram.

Under Eye, check Enable to display the eye diagram.

Check Apply to Zoom to eye diagram only the zoomed section of the source decode waveform. Eye measurements
will also reflect only this zoomed section.

The Bitrate is automatically read from the decoder setup. This value is linked to the decoder bit rate setting, and
changing it in either place will update both settings.

The Upsample factor increases the number of sample points used to compose the eye diagram. Increase from 1 to
a higher number (e.g. 5) to fill in gaps. Gaps can occur when the bitrate is extremely close to a submultiple of the
sampling rate, such that the sampling of the waveform does not move throughout the entire unit interval. Gaps can
also occur when using a record length that does not sample a sufficiently large number of unit intervals.

Choose to display the Eye Height or Eye Width measurement parameters. These are added to the Measure table in
the first open parameter slots.

Check Auto Scale to rescale the eye diagram to fit the entire grid.
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The Eye Style may utilize color-graded or analog persistence:

l

With color-graded persistence , pixels are given a color based on the pixel's relative population and the
selected Eye Saturation. The color palette ranges from violet to red.

l

With analog persistence , the color used mimicks the relative intensity that would be seen on an analog
oscilloscope.

Use the Eye Saturation slider to adjust the color grading or intensity. Slide to the left to reduce the threshold required
to reach saturation.

Eye Mask Test
Under Mask, check Enable to turn on eye mask testing.

Select to use either a Standard or Custommask, then either select the Standard Mask or Browse to and select your
customMask File.

Tip: Masks previously created on the instrument are stored in D:\Masks. For ease of selection, copy other
.msk files to this location.

Check Mask Failure On to mark the parts of the eye diagram that fail the mask test. Mask violations appear as red
failure indicators where the eye diagram intersects the mask.

Check Failure Location to display the Mask Failure Locator dialog.

Check Mask Hit(s) to display the number of hits in the Measure table.

Check Stop on Failure to stop acquisition when a mask violation occurs.

Mask Failure Locator Dialog
Use this dialog to quickly search the acquisition for eye diagrammask test failures.

Check Failure Location to mark the failure on the source trace. Check Stop On Failure to stop acquisition whenever
an eye mask failure occurs.

In #UI Displayed, enter the number of UIs surrounding the mask violation to display as "padding."

Enter the Max Failures to retain in the Eye Mask Failure list.

Select from the Eye Mask Failure list to mark and zoom to the location of that failure. Yellow circles appear over the
red failure indicators to show the location of the failure.
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USB4-SB Physical Layer Testing
The USB4-SB TDMP option enables you to run physical layer tests defined by the USB4-SB standard concurrent with
the waveform decoding. This allows you to gain insight into signal performance that is useful for debugging prior to
compliance testing.

To access the physical layer tests, from the menu bar choose Analysis > USB4-SB.

Choose from among the standard conformance tests and configure them for your signals. Pre-defined tests can be
quickly disabled/re-enabled by clearing or marking its respective checkbox (USB4-SB n) on the USB4-SB dialog.

1. On the USB4-SB dialog, check Enable and choose the Source decoder. The signal measured is that set as the
Source for the decoder (e.g., SBTX, SBRX or Both).

2. Check Show Decode if you wish to display the decoded source waveform and table along with the PHY
measurements.

3. To gate measurements to only the zoomed area (one or several highlighted rows of the decoder table), check
Apply Only to Zoom.

Tip: The Apply Only to Zoom setting will gate all measurements to the current zoom region. Zoom
applies to the selected packet by default, but if the zoom region is changed to include multiple
packets, then all packets in the zoom window will be included in the measurement table. If you want
to set a particular measurement on only a single row of the table, it is best to set the specific Index
number on the Measure dialog when configuring that measurement.

4. Open the Measure dialog, select the test number (USB4-SB n) and Measurement. Be sure it is checked On to
add it to the table.

5. Choose to Measure on All or One decoded packet.

If One, enter the Index number of the packet. This is the number of the row on the USB4-SB decoder result
table.

6. Use the Histogram, Track, and Trend buttons on the Measure dialog to quickly plot the test measurement
results on a separate grid.

If you have not already completed decoder setup, click Show Decode Setup on the USB4-SB dialog and configure the
source decoder. All tests are run on the decoded waveform results. The inputs measured are defined with the
decoder.

Tip: If you exit the PHY test dialogs to make decoder settings, touch the far left cell of the USB4-SB
measurement table to return to the physical layer tests.
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USB4-SB PHY measurements applied to the entire decoded signal.

USB4-SB PHY measurements applied to only the Zoom region (yellow rows) of the decoding.
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Appendix A: Automating the Decoder
As with all other oscilloscope settings, decoder features such as result table configuration and export can be
configured remotely using COM Automation.

Note: The examples shown here were taken from a CAN FD decoding, but all decoder result tables share the
same Automation structure.

Configuring the Decoder
The object path to the decoder Control Variables (CVARs) is:

app.SerialDecode.Decoden

Where n is the decoder number, 1 to 4. All relevant decoder objects will be nested under this. Use the MAUI Browser
utility (installed on the oscilloscope desktop) to view the entire object hierarchy.

Accessing the Result Table
The decoder Result Table is a complex matrix with secondary tables nested within some of its cells. The table data
can be accessed using the Automation object:

app.SerialDecode.Decoden.out.Result.cellvalue(RowA, ColA)(RowB, ColB)

Where:

n:= 1 to 4

RowA:= 0 to K (0=Row Index Number)

ColA:= 0 to L (0=Column Header)

RowB:= 0=MeasuredValue, 1=StartTime, 2=StopTime

ColB:= 0 to M

Complicating the matter of accessing the table is that there are two types of cell that may appear in the Result table,
Simple Cell and Table Cell, which are accessed in slightly different ways, and that some columns are always hidden
from view, yet they are still counted among the columns when querying.

Reading the Structure of the Result Table
In order to successfully access the data, it is necessary to first ascertain howmany rows and columns are actually in
your decoder result table, and what cell type is used for the column of data you wish to read.

To do this, we have provided the script, ExampleTableSerialDecode.vbs, which by default installs into oscilloscope:
C:\LeCroy\XStream\Scripts\Automation\ExampleTableSerialDecode.vbs.

Tip: This script may also be used as a basis for your own remote control programs, or used as is to read
decoder table data.
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With the decoder table populated, run the script from the oscilloscope (or a PC if you have a remote connection to
the oscilloscope). The script will generate the comma-delimited file, ExampleTableSerialDecode.txt, which may be
imported into Excel or other spreadsheet software to show the table structure.

Example spreadsheet after importing ExampleTableSerialDecode.txt.

The first two rows of the imported file will show the total number of rows and columns in the table, in this example 8
rows and 34 columns. This indicates the range of your RowA and ColA keys.

The third row of the imported file will replicate the column headers of the Result Table (0), with individual records
(frames, messages, etc., depending on how you have "packetized" the decoding) appearing in subsequent rows (1-n).

Counting from 0 at the far left (Row Index Number), find the column of the data you wish to access. That will be the
ColA key in your script.

Note: Do not confuse the number/letter of the cells in the imported file with the rows/columns of the Result
Table.

Hidden columns (whether hidden by you or the software) must still be counted, so, in the example above, PRIO is
column 3, making ID column 4, and so forth. So, if you wished to access the ID of record 6, the first argument of your
query would be: (6,4)

Within each column, Simple Cells contain a single value that appears at the specified location in the table. In the
above example, columns 0 through 2 are Simple Cells. Simple Cell VBS access syntax is:

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(RowA,ColA)'

However, many cells of the Result Table are the Table Cell type, nested tables that may contain multiple "B" columns
and always three "B" rows that, when coupled with the column key, each return a different component of the
measurement: (0,ColB) = MeasuredValue, (1,ColB)= StartTime, (2,ColB) = StopTime. These cells can be identified by
the list of semi-colon delimited values within them. The first three values in the list are Col0, the second three values
are Col1, and so forth.

To access Table Cells, the (RowB,ColB) argument is sent in a second parenthesis, following the A "locators":

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(RowA,ColA)(RowB, ColB)'

Although the image above does now show it, the ID and IDE columns each contain a single-column, three-row
nested table. To read the values from such columns, you would add the argument (0,0) following your "locators":
(RowA,4),(0,0) and (RowA,6),(0,0) respectively.

Reading the Data column (RowA,12) is more complicated, because it contains amulti-column, three-row nested
table, as indicated by the longer list of values. To access the full Data column value for each record, all ColBs must
be called by your script.

For example, if these were your decoder results:
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The following table shows example VBS queries you might add to a remote control program to read data from the
decoder result table.

Remote Queries Returned Value
(s)

What Is Read by
Query

vbs? 'return=app.SerialDecode.Decode1.out.Result.rows' 8 Number of table rows
(incl. header Row 0)

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,0)’
vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,1)'
vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,2)'

6
2.58442...E-03
FD

Value in first 3 columns
of Row 6, including:
Index # in Row 6 Col 0
Time in Row 6 Col 1
Format in Row 6 Col 2

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,12)(0,0)' 128 Data value in ColB0 of
Row 6 Col 12

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,12)(1,0)' 2.62461...E-03 StartTime of Data in
ColB0 of Row 6 Col 12
(hidden)

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,12)(2,0)' 2.62911...E-03 StopTime of Data in
ColB0 of Row 6 Col 12

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,12)(0,1)' 72 Data value in ColB1 of
Row 6 Col 12

vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(6,12)(1,1)' 2.62911...E-03 StartTime of Data in
ColB1 of Row 6 Col 12
(hidden)

Modifying the Result Table
The CVAR app.SerialDecode.Decoden.Decode.ColumnState contains a pipe-delimited list of all the table columns
and their current state (visible=on, hidden=off). For example:

app.SerialDecode.Decode1.Decode.ColumnState = "Idx=On|Time=On|Data=On|..."

If you wish to hide or display table columns, send the full string with the state changed from "on" to "off", or vice
versa, rather than remove any column from the list.
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Technical Support
Live Support
Registered users can contact their local Teledyne LeCroy service center at the number listed on our website.

You can also submit Technical Support requests via the website at:

teledynelecroy.com/support/techhelp

Resources
Teledyne LeCroy publishes a free Technical Library on its website. Manuals, tutorials, application notes, white
papers, and videos are available to help you get the most out of your Teledyne LeCroy products. Visit:

teledynelecroy.com/support/techlib

The Datasheet published on the product page contains the detailed product specifications.

Service Centers
For a complete list of offices by country, including our sales & distribution partners, visit:

teledynelecroy.com/support/contact

Teledyne LeCroy
700 Chestnut Ridge Road
Chestnut Ridge, NY, 10977, USA
teledynelecroy.com

Sales and Service:
Ph: 800-553-2769 / 845-425-2000
FAX: 845-578-5985
contact.corp@teledynelecroy.com

Support:
Ph: 800-553-2769
customersupport@teledynelecroy.com
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